
1Make the Connections  If cassette dubbing 
is your task du jour, connect the audio cable’s RCA 
connectors to your cassette deck’s left and right audio-
out jacks. If you’re ripping vinyl, you can’t connect 

your Mac directly to a turntable because you need a preamp to 
boost the signal to line level. Instead, hook up the turntable to 
your receiver as you normally would or to a preamp like Griffi n’s 
PowerWave ($100, www.griffi ntechnology.com; see our review 
on p50) or a cheapie $20 Radio Shack device. Then connect the 
audio cable’s RCA connectors to the receiver’s or preamp’s left 
and right auxiliary, tape record, or similar audio out. Next, plug 
the stereo miniplug into your Mac’s audio-in jack. If your Mac 
lacks an audio in, you’ll need a USB audio-input device to make 
the connection. Plug the USB device into your Mac’s USB port, 
and then plug the audio cable’s miniplug into the USB device.

If your Mac lacks audio in, 
Griffi n’s iMic supplies the 

needed audio jack via USB.

Digitize Vinyl and 
Audiocassettes
by Kris Fong

WHAT YOU NEED
• Turntable with stereo receiver or 

preamp, and/or cassette deck
• Headphones or speakers 

(for monitoring)
• Records and/or audiocassettes
• Stereo RCA to 1/8-inch stereo 

miniplug cable (about $5 at 
electronics stores)

• USB audio-input device if your Mac 
lacks an audio input (Griffin’s iMic, 
$35, www.griffintechnology.com)

• Audio-recording app such 
as Black Cat Systems’ 
Audiocorder (donationware, 
www.blackcatsystems.com) or 
Felt Tip Software’s Sound Studio 
($49.99, www.felttip.com)

W e’ve spent a small fortune over the past 15 years, 
slowly replacing some of our favorite vinyl records and 
audiocassette tapes with their CD equivalents just so 

we could play the albums at work or on the go. But what about all 
those old records and tapes that contain a single 
great song, or the ones that are out of print, or the 
ones we can’t seem to justify buying again? Rather 
than wait for KTEL’s next Best of the Screamin’ 

’80s Hair Bands compilation, we can simply record our old albums 
and tapes on the Mac and burn the fi les onto CDs for play in the car 
or offi ce, or use iTunes to convert them into MP3s for our iPod.

Digitizing analog recordings is easy, provided that you still have a 
turntable and/or cassette deck. If you’re looking to turn your historic 
collection into CDs or MP3s, here’s how. And for those interested in 
getting the best audio possible from a scratchy old record or hissy 
tape, we also show you how to clean up digital fi les.

ON THE
DISC

Audiocorder 3.7.1 and Audiocorder 3.7.1 and 
Sound Studio 2.1

If you’re too cheap to shell out $9.99 for 
a digital download of one of your ancient 
records, then record your album yourself 
onto your Mac’s hard drive.
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4Give It Some Gain  To preview the volume 
level coming into your Mac, start playing your record 
or tape. Adjust the Gain slider so that the audio level 
is strong—the bar should dance predominantly in 

whatever level color the app supports (usually green, yellow, or 
both; Audiocorder displays green when previewing and yellow 
when recording), without going into the red, which will cause 
distortion. Don’t set the gain too low or you may end up with a 
hissy recording.

5Ready, Set, Record  You can record songs 
individually, or record an entire side of an album or 
cassette in one take and edit the fi le afterward. Cue 
up your fi rst song, click Record in your audio app, and 

play the album or cassette. Keep an eye on the levels to make 
sure the audio doesn’t peak to the red. If it does, stop recording, 
notch down the Gain a tad, and start again. When the song or 
side ends, click Stop, and then stop the song on your turntable 
or cassette deck. If the app doesn’t save the fi le automatically, 
do so manually. Repeat for other songs. If you recorded songs 
individually and don’t want to do cleanup work, you can burn 
these CD-ready fi les onto a CD-R as an audio CD, or use iTunes 
to convert them into MP3 fi les for play in iTunes or an MP3 
player. If you need to do some editing, read on.

2Select Your Mac’s Input  To monitor the sound, 
either plug headphones into your cassette deck or stereo 
receiver, or connect a pair of speakers to your receiver. 
We don’t recommend monitoring sound from your Mac 

due to possible latency (sound delay) problems—you could wind 
up chopping off a song’s beginning. Set your Mac’s input to record 
either from its sound input (if your Mac has an audio-in jack) or via 
a USB device. Classic users: From the Apple menu, select Control 
Panels > Sound. Click the Input tab and select the desired input from 
those displayed. OS X users: Select System Preferences from the 
Apple menu, and click Sound to display its preferences. Then click 
the Input tab and select the desired input from those displayed.

3Establish Quality Control  Stick a record 
on your turntable or a cassette in your deck, power 
everything up, and then launch your audio app. We used 
Black Cat Systems’ Audiocorder—if you’re not, apply these 

instructions to your own app. To get CD-quality audio, set your app 
to record 44.1KHz, 16-bit stereo sound in AIFF format—we selected 
44100 kHz, 16 Bits, Stereo, and AIFF from Audiocorder’s respective 
pop-up menus. To set the sound input, we also selected iMic USB 
Audio System from the pop-up menu under the Start Trigger Length 
slider (this automatically changes the pop-up underneath to 
the same selection). Choose your own input device from these 
pop-up menus.

Because Audiocorder ignored our sound input preferences 
(other apps don’t), we chose the iMic input manually from the 
pop-up menu.

To get external audio into your Mac, choose the sound input for 
your setup in Preferences.

To digitize sound, just click Record, start playing your record or 
cassette, and keep an eye on those levels.

To prevent distortion, preview a bit of your album’s volume level 
and take the Gain down a notch if the level spikes to red.
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2Isolate Songs  If you recorded your songs 
collectively, isolate the songs by chopping up the fi le. 
Using the waveform overview (top two tracks), click an 
area where the waveform fl attens (picture the waveform 

as a sausage and look for the tie-off point). In the zoomed-in 
tracks, click the fl at portion of the wave, and click Play to hear 
whether you indeed landed between two songs. If not, keep 
looking. If so, click the left track’s gray bar anywhere within the 
break. From the Insert menu, select Marker. Seek out all other 
breaks and mark these as well. Then select Split By Markers from 
the Edit menu. In the resulting dialog, choose where you want your 
individual songs saved, and click OK. Rename these fi les by song 
title and remove unwanted audio before and after each song as 
you did in step 1.

Isolate songs 
from a collective 

recording by fi rst 
marking the break 

points, and then 
splitting the clip at 

each marker.

1Remove Unwanted Extras  To remove extra 
audio before a song, open the fi le in Sound Studio, click 
Play, and study the zoomed-in waveforms (bottom two 
tracks) as the playhead scrolls over them—the bigger the 

wave, the louder the sound. Silence appears as a straight, horizontal 
line. In our example, there are waveform spikes at the beginning 
where our turntable needle landed on the record, followed by some 
minimal noise before the song kicks in just after the 6-second mark. 
To get rid of the extra, click the left track’s gray bar (this selects the 
left and right tracks simultaneously) and drag from the beginning 
to the point just before the song starts. From the Edit menu, select 
Cut to delete. If you recorded songs individually, repeat this process 
accordingly to remove stuff at the end, and then skip to step 3.

To get rid 
of a lengthy 

intro, just 
click and 
drag the 

waveforms 
to select and 

cut them.

by Kris Fong
Clean Up Digitized Audio Files

WHAT YOU NEED
 • For simple clip editing, any audio-editing 

app, such as Kumulipo’s Jasmine ($29.95, 
www.kumulipo.com), Apple’s QuickTime 
Pro ($29.95, www.apple.com), or Felt Tip 
Software’s Sound Studio

• For editing and noise removal, 
any audio-filtering app, such 
as Bias’s Peak ($499, www
.bias-inc.com), Arboretum’s RayGun 
($99, www.arboretum.com), or 
Felt Tip Software’s Sound Studio

You’ve digitized your vinyl and tape collection, but your recordings 
sound more like a Rice Krispies jingle. While you should’ve 

thoroughly cleaned your records before taking them out for a spin, 
we won’t make you redo the recording—you can’t avoid a few clicks, 
crackles, and pops anyway. But you can clean up many minor noises 
and tape hiss after the fact. 

Though you can’t remove continuous noise without lowering sound 
quality, you can diminish it without making your music sound as if it 
were being piped in from a sewer. Here’s how to do just that, as well 
as how to isolate individual songs from one collective recording and 
remove unwanted audio before and after a song. We used Sound 
Studio for everything—if you’re not, just apply our instructions to 
your application of choice.

ON THE
DISC

Jasmine 1.5.7, Jasmine 1.5.7, 
Montage w/Raygun 
1.1 demo, and Sound 
Studio 2.1

AUDIO WAVEFORM

TIMELINE
(IN SECONDS)

CURRENT 
ZOOM-IN VIEW

ZOOM OUT

ZOOM IN

LEFT TRACK
(OVERVIEW)

RIGHT TRACK
(OVERVIEW)

LEFT TRACK
(ZOOM-IN VIEW)

RIGHT TRACK
(ZOOM-IN VIEW)
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3Clean Out Clicks  If you recorded from vinyl, your 
recording probably has a few clicks and pops in it. To get 
rid of these sounds, open a song in Sound Studio, click 
Play to listen, and click Stop when you hear a click or pop. 

The noise should appear as a spike in the waveform. To get rid of it, 
click the left track’s gray bar just before the spike starts and drag 
to the point where it ends. Then select Interpolate (Repair) from the 
Filter menu to knock it out. To review your handiwork, click the wave 
before the repaired area, and then click Play. Repeat for all other 
pops and clicks.

Our cursor in the before shot points to a click; once we interpolate 
it, the noise disappears (after).

4Remove Crackle and Hiss from 
Silent Passages  Removing noise that plays 
throughout a clip is diffi cult. Pro packages like Peak, 
along with expert audio-engineering skills, can yield 

good results, but there are quick-and-dirty methods. To get 
rid of crackling and hiss in a silent part of a song, highlight 
the affected area, and then select Fade Special from the Filter 
menu. In the resulting dialog, click Preview to hear the passage. 
Then click in the grid to draw a U shape so that the sound 
volume fades quickly at the start of the affected area, remains 
silent through it, and quickly returns to normal volume at the 
end. Click OK, click the waveform before the repaired spot, and 
click Play to review your work.

PREAMP PROBLEMS
If you’re recording from a turntable-and-preamp combo instead 
of a turntable and stereo receiver, your music may sound like it 
was recorded in a tin can. This is because vinyl is recorded with 
reduced lower frequencies and boosted higher frequencies, 
known as the RIAA curve. This technology was an industry-
standard way of getting better sound from and fi tting more 
recording time on a record, while keeping the needle from jumping 
off it during play. Stereo receivers boost these frequencies back 

to normal levels when you play a record, but preamps won’t. 
However, you can reintroduce and rebalance the frequencies in 
your digitized music by altering the EQ settings in your audio app.

One other turntable trouble spot: If you hear a low-frequency 
hum when you try to preview a record, you’re hearing ground 
hum. This is caused when a preamp amplifi es sound from an 
ungrounded device, such as your turntable. To get rid of it, just 
take your turntable’s grounding wire and wrap it around the 
bottom prong of a three-prong plug (like the one on your power 
strip), and plug it into a grounded outlet.

This area 
between guitar 
riffs should be 
silent, but it’s 
not. Using the 
Fade Special 
fi lter, we 
dropped the 
volume on 
this spot.

5Lower Noise  It’s almost impossible to 
remove continuous crackles and hiss without 
sacrifi cing sound quality (unless you’re a pro 
with a pro app). Expect to live with a bit of 

residual noise if you want your song to sound good. 
To diminish noise presence a bit, though, click the 
left track’s gray bar anywhere and press Command-
A to select all. From the Filter menu, select Graphic 
EQ, then 30-Band EQ to open the fi lter. Click Preview 
to start playing the song, and then experiment by 
selecting a high-frequency slider and notching it down 
to hear if it lessens the noise. Listen and experiment. 
Most hisses and crackles peak in the 10KHz to 12KHz 
range—start here, but listen carefully to sound quality, 
too. When you fi nd a happy medium, click OK.

We got rid of the severe crackle in our song by taking these two 
frequency sliders down a notch.
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Kris Fong is sorry to report that no amount of EQ will 
silence a hissing cat.


